
Welcome

Congratulations on selecting TurboZIP, a powerful, yet easy to use Total Archive Management tool. The system 
is not limited to merely opening ZIP files -- it has a wide range of specialized components to make your computing 
life faster, easier, and more secure.
You can learn all about TurboZIP by using the browse (arrow) buttons in the Windows Help toolbar. The TurboZIP 
Features page has links to an explanation of each item. The "How To" section that follows can be read in 
sequence, like a tutorial, for an overview of how to use the power of TurboZIP. 
You may also simply begin to use TurboZIP, with its intuitive toolbar, menus and dialogs. Click on Help or press F1 
at any time to access this context-sensitive, fully indexed help system.

This file uses some special symbols, as follows:
is a quick operation you can do right from Turbo Browser or 
Windows Explorer
starts off from the perspective of using the TurboZIP window

tells you about a helpful tip or hint
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,}

makes other related information available

The following overview of TurboZIP may be read to get an overall understanding of the system's capabilities. A 
hypertext list of system highlights titled TurboZIP Features follows this page. 

Executive Overview
TurboZIP is a Total Archive Management tool with an easy to use interface, making it quickly accessible to 
every user. The system provides complete internal support for opening and viewing all the most popular 
Archive and E-Mail attachment formats, and can create ZIP files as well as optional ARJ and LHA formats. 

Intuitive toolbars, wizards, context-sensitive menus, and dialogs, along with convenient Explorer-
compatible right mouse menus, are always at the ready. Hidden beneath the easy to use interface is a 
powerful proprietary archiving engine, with multi-threading and spooling features that can do multiple 
tasks at the same time, which is why it is incredibly responsive. TurboZIP can actually begin a new ZIP 
operation while an exceptionally large file is in the process of being opened.

Among the most popular of its list of the TurboZIP talents are viewing capabilities: any file within an Archive or
E-Mail can be picked and previewed, using one of over 100 lightning-quick system filters. TurboZIP native 
support includes word processing, image, spreadsheet, presentation, multimedia, and animation formats, 
as well as ActiveX and ActiveMovie integration. Special toolbars and right mouse menus, tailored to each type 
of file, are automatically made available so you can manipulate and print a file with or without its original program. 

This strength, combined with the organizational features of ZIP Sets for grouping files on your hard disk and 
removable diskettes, lets you explore new ways of using archives. The TurboZIP Auto Scan feature can load 
files you select into ZIP Sets for easy organization. Then, the powerful search abilities can find individual files 
inside these archives, when they are needed, and even more impressively look inside specially selected files 
for text. This ability brings all kinds of new opportunities for file storage that couldn't otherwise be done 
before, but now is within your reach with TurboZIP.

A special TurboZIP feature is Auto Backup Scripts, easy to use files that store the details of creating a particular 
archive file so you can use it again and again, such as for file backups and archives you need to remake 
frequently. You can use command line support and other special TurboZIP features to use scheduling programs
to perform these backups in an unattended mode, so while you sleep, TurboZIP is archiving and protecting 
important files. Other features include virus scanning, self-extracting archives, encryption, disk spanning, 
printing, drag and drop, multiple file operations, MAPI-compatible file E-Mail, and complete compatibility with
universal archive standards. 

TurboZIP offers significant advantages with its Total Archive Management philosophy. If they want, and when 



they need to, users can go far beyond merely unzipping archives. TurboZIP lets you tap into the power that 
archives can offer to enhance your computing activities.

Move to the TurboZIP Features topic for a hypertext list of system highlights.



TurboZIP Features

TurboZIP provides a wealth of features, some of which are listed here. Hyperlinks jump to related topics in this 
help file for additional details on how to use each feature.
Open All Major Archive and E-Mail Attachment Formats, including ZIP, CAB, ARJ, and LHA (lzh) archives, UU 

Encoded E-Mail (uue, uu) attachments, Self-Extracting ZIP files (exe), Unix Z archives (gz, taz, tgz, z), UNIX 
TAR archives, MIME e-mail (mme, mim, b64), Mac BinHex (bhx, hqx).

Create Popular Archive and E-Mail Files, including ZIP, ARJ, and LHA (lzh) archives, UU Encoded E-Mail (uue) 
files, and Self-Extracting ZIP (exe) files.

Multithreading Technology enables multiple file operations (zipping and unzipping), for opening more than 
one archive and other simultaneous operations.

SPEED!!! TurboZIP is now up to ten times faster than the prior release (TurboZIP 97), which was reported by PC 
Magazine as being 25 to 40 percent faster than the competition.

Display file contents within Archives and E-Mail attachments without opening them. Lightning-quick 
multithreaded operations allow TurboZIP to display files within Archives and E-Mail files, bringing all the 
attendant advantages of previewing content. This function is not just ideal for analyzing and categorizing files, 
but, combined with Find File capabilities can bring archiving opportunities that were previously impractical. 

Print files within Archives and E-Mail attachments using the TurboZIP native filter support, ActiveX, or by 
accessing the associated application.

Extract and Create Files without using the TurboZIP interface; options allow you to bypass the display and 
use defaults

Drag and Drop files from Turbo Browser or Windows Explorer and within TurboZIP
Display subfolders within Archives in a file tree format.
Organize Archives and E-Mail messages into user-defined categories without moving the actual files.
Catalog files on removable media, and review their content and find files without the media being present.
Auto Scan selected drives, folders, and subfolders to add selected file formats to ZIP Sets.
Find files in Archives and E-Mail files.
Find text strings within files in Archives and E-Mail attachments, using optional "fuzzy search" capabilities,

precision search criteria, and the vast array of TurboZIP file access filters.
Print listings of the files within archives.
Create Multiple Disk Archives (disk spanning) to archive and transport large files using multiple diskettes.
Use Right Mouse Menu entries in Turbo Browser or Windows Explorer to make archive operations easy and 

accessible
Command Line Switches are available for automating routine and unattended operations, such as running Auto 

Backup Scripts to back up files during off hours.
Create Self-Extracting ZIP files for the convenient distribution of archives to recipients who may lack an archive 

utility.
Virus Scanner Interface enables users to scan files using their favorite anti-virus program.
Keyboard Shortcuts are available for many operations
Password protect files within ZIP archives using standard encryption methods. 
File Filtering automatically includes or excludes files from new archives.
File Properties can be viewed and changed.
ZIP Comments can be viewed, added, and edited. 
TurboZIP Toolbar, Menu, and Right Mouse Menu access for convenient access to all functions.



All about ZIP, Archive, and E-Mail files

ZIP, LHA, ARJ, CAB and other archive formats are packages that contain one or more file(s) for the convenience 
of computer users, and offer several advantages. These files are generally compressed, to save disk space and 
online transfer time. In addition, since they can contain more than one file, archives are a convenient way to group 
files for delivery or archiving. Some also include internal coding that can tell you if the contents have somehow 
been corrupted, so you obtain an accurate copy. 
UUE, MIME, BinHex and other E-Mail file formats are specialized files for attaching to messages. Non-text files 
include characters that cannot be included in the ASCII (text) transmissions that E-Mail permits, so these formats 
were developed. Files are converted to one of these formats and then appended to a message. See How to E-Mail
UU Encoded files or How To Decode E-Mail attachments for details.

Definitions of Popular Terms:
Archive - the word "archive" is a general term that is often used interchangeably with "ZIP file," although there are
many archive formats, such as ARJ, LHA, and CAB. Archive files are often used to archive, or store groups of files 
that are not often needed, so they take up less disk space and are wrapped up into one file, rather than several 
separate files. Their use is also common on the Internet, where their smaller size reduce file transfer times. 
TurboZIP can open all of the popular files and create ZIP files, the most popular type, as well as the ARJ and LHA 
formats, with additional support. 
Unarchive - to open a ZIP, ARJ, LHA, CAB, or other type of Archive or E-Mail file (E-Mail files are actually being 
decoded, but you may find the term used interchangeably).
Extract - when files are returned to their original state (extracted) from an archive or encoded file.
Decode - when a file is converted from one format to another, such as with UUE or MIME email files.
Encode - when a file converted to another format, such as UUE or MIME.
Encrypt - when a file is processed using a password, it is "scrambled" and therefore unreadable. A password is 
necessary to decrypt it.
Password - when a file is processed using password protection, it is "scrambled," or encrypted, and therefore 
unreadable without the use of that secret password.
Self-Extracting ZIP file - a ZIP file that is processed and converted to an EXEcutable file, so it can be opened 
without requiring a ZIP utility.



Tips for Using TurboZIP

The many TurboZIP capabilities can be applied to a long list of tasks. Here are a few examples that may help to 
stir your imagination:

Weeding Out Mystery Files
Download folders manage to grow quickly, and those cryptic file names are no help in deciding whether they 
should be kept, moved to diskette, used, or deleted. Use the TurboZIP Preview Pane to look at readme.txt, 
file_id.diz, or similar files to help identify them without unarchiving them. Then, you can use Ctrl+Delete to delete 
unneeded files from within TurboZIP, or rename them with less cryptic names and move them to special folders.

Archiving Old Files
Our favorite local newspaper editor has thousands of stories from past papers in ASCII and Microsoft Word 
document format. Until now, it was a hit or miss situation to locate a related, past story, for background on a 
current one.
These thousands of files have now been archived into date ranged ZIP files by TurboZIP and placed on removable
disks. Now, when a story needs researching, our editor sends TurboZIP after the facts, using the Find In Files 
function to search through archives after that pertinent text string.

Finding Fonts
Another user has printed directories and zipped up hundreds of TrueType fonts as she acquired them, all in a 
slightly disorganized manner. Finding one when she needs it can be a chore. However, after choosing one from 
her printouts, she uses TurboZIP to search through the ZIP files to find the filename. She can even verify that it is 
the right one by using the Preview Pane.

Frequent Backups for Maximum Safety
Experienced users know the potential danger for disaster as a programming, documentation, or other project 
creeps forward through many stages of development. Frequent backups of source files are a breeze with 
TurboZIP. Our documentation team has an Auto Backup Script that can quickly ZIP up all the source 
documentation for this help system and save it to a floppy diskette, as frequently as desired, so any potential 
disaster can be averted. The Add date and time to the ZIP file name Auto Backup option ensures that older 
backups are not overwritten, so the development history is intact.
 



This instruction applies to the use of
Turbo Browser or Windows Explorer 
file management programs.



This instruction applies to the use of
the TurboZIP interface.



Use the TurboZIP Window (How to)

Many archiving and unarchiving operations can be done without opening the TurboZIP window. However, the 
system offers a wide range of archive management and viewing tools that you will grow to appreciate and use 
regularly.

Please note that pane #3 can be located alongside #2, or hidden. 
Windows can also be resized to your preference. (see below)
1. ZIP Sets

The left-most pane shows ZIP Sets and files in an expandable, Explorer-style view. ZIP Sets are a management
tool to help you organize archive and e-mail files on and off your computer. Read How To Create and Use ZIP 
Sets for a full explanation of this very useful feature.

 The full path can be hidden by unchecking the Display the full path of the Archive and Email option in the Program 
Options | Setup dialog. 
2. File List 

When a ZIP Set is clicked and highlighted, all the archives within that set are listed here. Your choices for 
viewing them are the same as Windows Explorer: Large Icons, Small Icons, List, or Details, that can be set from
the View menu. 
When an archive is clicked and highlighted, the contents of the file is shown in this pane. Again, you have the 
same choices for displaying the files.

 When in the Details view, clicking on any heading sorts the list by that heading. If Internet Explorer 4.0 (Windows 
98) is installed the file list columns may be rearranged by dragging the column tabs to the left or right.
3. Preview

Highlight any file in the File List pane, and the contents is displayed in this area. TurboZIP supports over 100 of 
the most popular file formats, so you can preview images, word processing files, spreadsheets, animations, 
videos, and more. Further information on this helpful feature is included in the Preview Pane topic.

 The Preview pane can be placed alongside, instead of beneath, the File List pane, or hidden. Choose Preview 
Pane from the View menu, and select Vertical Preview Pane or None. 

 Click your right mouse button in any window! Depending on the ZIP Set, file, file being previewed, etc., different 
menu choices are provided for quick and convenient operations.

 You can change the amount of space used for each window by placing your cursor on any window boundary until it
turns into an arrow, and then dragging the pane to the size desired.

{button ,AL(`How To',0,`',`')} Other "How To" topics



Extract files from a ZIP* or Other Archive (How To)
These instructions apply to opening all *supported archive and email     formats.   

 Right-click on the ZIP file or other supported archive and email format and choose the Extract with TurboZIP 
menu item.

OR

 Click on the Open toolbar button and select a ZIP file, or click on the Files of Type item in the Open File dialog to
select the type(s) of file(s) you wish to have displayed in the dialog and select the file.

Either action opens the Extract Wizard where you enter or browse for a folder to put the files. If you enter a folder 
that doesn’t already exist, TurboZIP will create it. Click on Select Destination Folder (Extract Wizard), for more 
details about that window.
Click on Finish to extract all the files from within the file.

Extract only selected files
You can select individual file(s) in an archive and only extract them, rather than the entire contents. Highlight the 
file(s) you want using standard file selection methods, before you begin the extraction process.

 You can look inside the ZIP before you extract all the files, and preview files to decide which you want to extract. 
Click on How To Open a ZIP File and look inside for instructions.
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Open a ZIP* or Other Archive and look inside (How To)
These instructions apply to opening and viewing all *supported archive and email formats.

 Right-click on the ZIP file or other supported archive and email format and choose the Open with TurboZIP 
menu item

OR

 Click on the Open toolbar button (or menu: File|Open) and use the familiar window to locate and open the ZIP file, 
or click on the Files of Type item in the Open File dialog to select the type(s) of file(s) you wish to have displayed in 
the dialog, and select the file.

As a result of either action, the file is then opened in the left pane of the TurboZIP window, and all of the files within
the archive are shown in the File List pane. 
Click on any file to view it in the Preview Pane. 
You can also launch any file to run it or open it using its associated application by double-clicking on it.
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Create a ZIP file (How To)

 Select file(s) from Windows Explorer using standard file selection methods, and click your right mouse button. 
Choose the Add to ZIP with TurboZIP menu item.

The Add Wizard: Select Destination Archive and Items to Add will be launched, and the file(s) you have selected
will automatically be inserted in the list. Just type in the new archive name, with path, or browse to an existing 
ZIP file, and click on Next.
The final Add Wizard: Review window allows you to view the options; use the Configure button to access the 
Archive Options to change them for this process if necessary. Click Finish to create your ZIP file.

OR

 Click on the New ZIP toolbar button, or select New from the File menu and choose ZIP.
The Add Wizard: Select Destination Archive and Items to Add will be launched. Use the Browse button to select 
files to be added to your new ZIP file, and specify wildcards if desired.
The final Add Wizard: Review window allows you to view the options; use the Configure button to access the 
Archive Options to change the options for this archive if necessary. Click Finish to create your ZIP file.

 TurboZIP can also Create ARJ and LHA archive files, if you find it necessary to use that archive format.

{button ,AL(`How To',0,`',`')} Other "How To" topics 



Create an ARJ or LHA file (How To)

 Select New from the File menu, and choose ARJ or LHA.
The Add Wizard: Select Destination Archive and Items to Add will be launched. Use the Browse button to select 
files to be added to your new ZIP file, and specify wildcards if desired.
The final Add Wizard: Review window allows you to view the options; use the Configure button to access the 
Archive Options to change the options for this archive if necessary. Click Finish to create your ARJ or LHA file.

 TurboZIP requires external programs if you wish to create ARJ or LHA archives. If the location of the external 
program has not been specified in Program Options, the External Program dialog will appear; further information is 
provided in that help file topic. 

 TurboZIP does not require external programs to extract files from ARJ or LHA archives.

{button ,AL(`How To',0,`',`')} Other "How To" topics 



Add Files to an existing ZIP, LHA, or ARJ (How To)

 Select file(s) from Windows Explorer using standard file selection methods, and drag and drop them on an existing 
ZIP, LHA (lzh), or ARJ file. You can drag an entire folder, as well as individual files.
The Add Wizard: Select Destination Archive and Items to Add will be launched, and the file(s) you have selected will 
automatically be inserted in the list. Click on Next to continue the process.

The final Add Wizard: Review window allows you to view the options, if necessary. Click Finish to create your 
ZIP, LHA (lzh), or ARJ file.

OR

 Open the existing ZIP, LHA (lzh), or ARJ file in TurboZIP, or highlight it in the ZIP Set or List pane. Click on the Add 
toolbar button, or select Add from the Archive menu.

The Add Wizard: Select Destination Archive and Items to Add will be launched with the file you selected inserted
in the list. Use the Browse button to select files to add to the existing ZIP file, and click on Next.
The final Add Wizard: Review window allows you to view the options, if necessary. Click Finish to create your 
ZIP, LHA (lzh), or ARJ file.
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Compress Folders and their contents (How To)

When you create an archive, you can include folders, their contents, and other aspects involving folders.
While navigating the file dialog to add files in the Add Wizard: Select Destination Archive and Items to Add (Add 
Wizard), you can highlight a folder and specify a wildcard entry in the File name box; the wildcard entry *.* will 
select all the files in that folder.
The choices made in the Advanced Compression tab of Archive Options under the Archive menu affect whether 
the folder names are stored. 
The Recurse Subfolders option, also in that tab, will include the files in subfolders inside the selected folders when
checked.
You can make choices to affect the file you are creating simply by clicking on the Configure button in the Review 
(Add Wizard) dialog. 

 Note that the options you choose are listed in the Review (Add Wizard) window so you can easily see if folder 
names are being stored and if subfolders are being recursed.
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Include or Exclude Paths in Archives (How To)

Careful thought should be given to whether it is necessary or desirable to save the folder paths in an archive. 
Once you have given the matter consideration, you can use TurboZIP options tailor your archive to meet each 
job's requirements.
The Advanced Compression tab in the Archive Options menu entry includes Subfolder options to store. Review 
that topic for an explanation of the effect of each choice.

 Choosing any of these options when adding files to an existing archive will not affect the files already stored.
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Create and Use ZIP Sets (How To)

ZIP Sets provide a superior method for organizing your archives and email files. Simply stated, ZIP Sets are a way
to group similar files (any supported archive or E-Mail file, not only ZIP files) without actually moving them from 
their original locations. These archives and email files can be anywhere on your disk, or even on removable disks 
and CD ROMs, but can still be placed into neatly organized categories. Review the list of benefits in this topic for 
ideas on how you can best utilize this feature.

How to… 
Create a ZIP Set - Choose New ZIP Set from the File menu; a new item is created, just like when you create a 

new folder in Windows Explorer. Simply alter the "New ZIP Set" title to your choice. 
Add Files to a ZIP Set -

Open an existing ZIP file while the ZIP Set name or a file within it is highlighted.
Create a new ZIP file while the ZIP Set name or a file within it is highlighted.
Use Auto Scan to read files from a target drive, folder, or sub-folders and add them.

Move Files between ZIP Sets - Drag the file from its current location to the ZIP Set folder title. Multiple files can 
be moved by highlighting a ZIP Set and using standard file selection methods to choose files from the File List 
pane, which can then be dragged to the desired ZIP Set.

Remove a File from a ZIP Set - Highlight the file and click on the Remove toolbar button.
Delete a File from your computer and Remove it from a ZIP Set - Highlight the file and click on the Delete 

toolbar button.
Remove a ZIP Set - Highlight the ZIP Set and click on the Remove toolbar button; all of the files in the ZIP Set will

also be removed.
Rename a ZIP Set - Highlight the ZIP Set and click twice, slowly, and replace the text, or select the Rename item 

from the File menu.
Sync a ZIP Set - Highlight the ZIP Set and click on the Sync ZIP Set item within the File menu. This action verifies 

that all of the member files are present on your hard drive and removes those that have been deleted by other 
means.

 Caution should be exercised when dealing with ZIP Sets that include files from removable media, like 
diskettes, CD ROM, and removable drives. If the Sync command is used and the removable media is not 
present, the files will be removed from the ZIP Set.

Uses and Benefits of ZIP Sets:
· Organize and categorize files without relocating them.
· Catalog files from removable media, such as diskettes, CD-ROM, and popular removable drives; listings of 

the files within each archive are retained by TurboZIP and can be viewed even when the media is not present.
· The Find in Files function can target individual ZIP Sets, narrowing the search and executing it more quickly.
The ZIP Set function creates index files, using the extension ".zif," located in the folder specified by is specified by 
the Tools | Program Options | Setup | ZIP Set folder menu entry.

 The full path shown in the ZIP Set window can be hidden by unchecking the Display the full path of the Archive and
Email option in the Program Options | Setup dialog.
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Create and Use Auto Backup Scripts (How To)

Auto Backup Scripts are a convenient method for routinely creating ZIP files, without the need to re-enter the 
information each time. This feature has many uses:
· for backing up files as protection from loss.
· to create a compact archive of special files, for transport on a diskette.
· for use as a template for the routine creation of a set of files for distribution.
· for unattended backups, using TurboZIP command line options and an external scheduling program.
TurboZIP saves the all of the criteria you choose when creating a ZIP from a group of files, including file selection, 
options, and where to create the ZIP file. These Auto Backup Script (.abs) files can then be used to routinely ZIP 
up the same group of files, folders, and the contents of folders if wildcards are used. The "Add date and time to the
ZIP file name" option lets you append the date and time to the file name, so generations of backups can be 
created without overwriting each other.

Creating an Auto Backup Script
Select Auto Backup Script from the File menu, and choose New. The familiar file dialog allows you to name and 
navigate to a folder for storing the new script file.
The steps that follow are the same as if you were creating a new ZIP file; you can review these steps in the How to
Create a ZIP file topic if necessary. However, in this case, all the options you choose will be saved as an Auto 
Backup Script file so it can be reused. In order to get the maximum benefit and use from these files, certain 
options should be carefully considered (click on the Configure button in the Review screen to access the Archive 
Options tabs). They may help you appreciate the flexibility and range of possible uses for TurboZIP Auto Backup 
Scripts.

The Compression Filters can be used to include or exclude particular file types
The Auto Backup tab offers the opportunity to suppress three items that may be unnecessary and undesirable 
when Auto Backup Scripts are involved, especially if they are being created in an unattended mode using 
Command Line Parameters. 
The Date Filter in the Compression tab can be used in conjunction with a wildcard selection, to only include files 
created after a given date.

When you are satisfied with your options in the final wizard screen, click on the FINISH BUTTON to save all the 
options you have chosen so they can be reused to recreate the file at a later time. Please note that a final 
confirmation screen asks if you want to create the ZIP file; you can choose not to create it, but the Auto Backup 
Script (.abs) script file will still be saved.

 The Setup tab in the Tools|Program Options menu item lets you choose a folder in which to store your Auto 
Backup Script library.

Editing an Auto Backup Script
Select Auto Backup Script from the File menu, and choose Edit. TurboZIP loads the script file and allows you to 
make any changes to any of the criteria as you recreate the Auto Backup Script.

Using Auto Backup Scripts
You can execute an Auto Backup Script simply by selecting Auto Backup from the TurboZIP Archive menu, and 
selecting an Auto Backup Script (.abs) file. The command will be executed immediately.
A potentially even quicker method is to simply double-click on an Auto Backup Script (.abs) file. TurboZIP is 
associated with that file extension and will create the archive.
The Command Line features offered by TurboZIP, combined with selected program options, can enable you to 
schedule unattended backups of files using Auto Backup Scripts. A sample command to create a ZIP file using a 
previously created "example.abs" file is shown below:
C:\Program Files\TurboZIP3\turbozip.exe /O "C:\ example.abs"
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Decode E-Mail attachments (How To)

TurboZIP can decode popular E-Mail file attachment formats so you may extract or view them using the TurboZIP 
preview pane . You use the same procedures for extracting or viewing E-Mail files as you would for ZIP files and 
other archives. But first, verify the attachment file's extension.

The file attachment's extension must agree with the attachment's file format in order for the program to use the 
proper conversion filter; if it is already .uue; .uu; .mme; .mim; .b64; .hqx; or .bhx, this concern does not apply. 
Sometimes, file attachments have names with generic extensions such as filename.001, but may also first have 
a line of text that mentions the format. The following are the E-Mail formats and the appropriate extensions for 
each; if your attachment does not have one of the extensions shown, it will be necessary to rename the file 
using the appropriate file extension. If you are unsure of the format you have been sent, try each.
UU Encoded - .uue, .uu
MIME - .mme .mim, or .b64
Mac BinHex - .hqx or .bhx

Once this step is taken, you may follow the instructions to:
Extract the files from a ZIP File (How To) to extract your E-Mail attachment, or Open a ZIP File and look inside 

(How To) to open and view the attachment, since the procedures are the same.

 Many E-Mail programs can automatically create and decode file attachments. Refer to your E-Mail program's 
documentation or help file.
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E-Mail UU Encoded files (How to)

Most E-Mail programs automatically create and decode file attachments, such as UUE, MIME, etc., without 
requiring an external program or process. Please refer to your E-Mail program's documentation for instructions for 
including file attachments. 

 If your E-Mail program is MAPI-compatible, such as Microsoft Mail and Outlook Express, you can E-Mail a file 
directly from TurboZIP. Just right click on a file in the ZIP Set window, and choose Send Mail from the menu.

However, TurboZIP is able to create UU Encoded files for use with programs that do not have an integrated file 
attachment function. Please see the help file section to Create UUEncoded Files. for details on how to make one.
You may want to refer to your E-Mail program's documentation to determine if there is an import function, to add 
the resulting UUE file to your message. Alternatively, a direct method for including a UUE file is to open the UUE 
file in Notepad, WordPad, or other text editor, copy the text to the clipboard, and paste it into an open, outgoing 
message.
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Create a Self-Extracting ZIP file (How To)

Self-Extracting ZIP files are ZIP archives that have been converted into an EXE file and can be opened without the
use of TurboZIP or other ZIP utilities. This convenience is especially useful when you are preparing a ZIP file and 
don't know if the recipient has a ZIP utility to open it, or if you just want to make it easier for them.
To create a Self-Extracting ZIP file, first create a ZIP file. Refer to the How To Create a ZIP file (How To) for 

instructions, if necessary.
If the file is not already in your TurboZIP ZIP Set window, please open it using TurboZIP.
Highlight the file, and choose the Make Self Extractor… entry from the Tools menu.
Complete the information in the dialog provided, and click to create a Self-Extracting ZIP file. For details on the 

features and options available, please consult the Make Self-Extracting EXE File topic that documents the 
dialog.

 If you require more extensively featured self-extractors, with options for program installations and CAB archive 
files, TurboSFX is another product from Pacific Gold Coast Corporation. Visit http://www.pgcc.com or contact your 
dealer for further information.
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Catalog Files on Removable Media (How To)

The TurboZIP ZIP Set feature is ideal for cataloging files that are stored on removable media, such as CD ROM, 
diskettes, and large format (100+ megabyte) removable disks and drives. 
First, consider which ZIP Set in which you would like to place the files, or if you want to create a new ZIP Set. 
Then, highlight the ZIP Set and use the AutoScan feature to automatically add all the files to the ZIP Set, or use 
the Open button to add individual files to the ZIP Set of your choice.

IMPORTANT: Do not use the Sync ZIP Set command in the File menu with ZIP Sets that have entries from 
removable media, unless the media is currently mounted. The Sync ZIP Set command is designed to update the 
ZIP Set, and if a file is no longer present it will be removed from the list. If the command is accidentally used, and 
files removed from your ZIP Set, you can return the media to your computer and use the Auto Scan feature to add 
them back.

{button ,AL(`How To',0,`',`')} Other "How To" topics



Find Files and Information Inside Files (How To)

TurboZIP includes powerful tools for locating specific files as well as for information within files that are within an 
archive. The features included in this feature open the door to a number of opportunities of which you can take 
advantage. An example is included at the close of this topic.

Find - search for text within a file
One of the two tools is designed for use in the Preview Pane. Simply right click on the displayed file and choose 
Find to open the dialog for entering your search criteria. Several options are available for narrowing your search by
using case sensitivity and matching the whole word. The function also includes an optional "fuzzy search," to 
widen your search to items close to your text input, for instances when the exact spelling is unknown. The help 
screen for the Find dialog includes details on each of the available options.

Find in Files
The Find in Files entry in the Tools menu is a comprehensive tool for searching one or more ZIP Sets or an 
individual file. When you access the Find in Files item from the Tools menu, the five tabs allow you to precisely 
define your search requirements:
You can restrict you search to a single file, a ZIP Set, or all ZIP Sets.
Searches can be filtered by date ranges, file attributes, and size ranges.
TurboZIP can search each file inside each archive, included in the above criteria, for text, using the same precise 
or "fuzzy" mechanism as described in the Find section above. An example describing a use for this powerful tool is
shown below. 
The Find in Files help topic details each of the items included, and the Find Results topic explains your options to 
view or extract the file.

Example:
A software reviewer has many hundreds of small, individual text and MS Word document files that are past 
reviews. The need for them is infrequent, and their cryptic file names are of little help when looking back for old 
reviews.
The reviewer has created multiple ZIP archives, and added them to a specific ZIP Set. Instead of nearly 6.5 
megabytes, they now occupy less than 2.9 megabytes and are kept on a removable disk.
The Find in Files tool can quickly search these archives for words or text strings and return the results in a Find 
Results listing, enabling the reviewer to view or extract any candidates.

{button ,AL(`How To',0,`',`')} Other "How To" topics



Print Files and File Lists (How To)

TurboZIP offers several ways to print files and file lists.
Files within archives that are displayed in the preview pane can be printed. Right click on the preview pane 
to print the file using TurboZIP (Print) or print it using the application program associated with that type of file.
Listings of the contents of a ZIP Set or an archive can be printed; simply highlight a ZIP Set or a file, and 
choose Print File List from the Archive menu. You can also choose Print File List Preview to print the report to the 
screen first, for your examination, and then print using the Print Preview dialog Print button.

{button ,AL(`How To',0,`',`')} Other "How To" topics



Bypass the TurboZIP Interface (How To)

Operations can be speeded by avoiding the use of the TurboZIP interface, provided the default choices are 
acceptable and the proper options chosen.
Unarchiving options to bypass the TurboZIP interface are specified in the Extraction Folder under Archive Options
under the Archive menu item. You may specify the folder in which the system will place the extracted files. Choices
include your temporary folder, the same folder as the ZIP file, and a specific default folder. 

 A key option, when checked, will create a new folder using the same name as the archive, within the folder you've 
specified. This can be especially useful when unzipping multiple files. 
Archiving can also bypass the TurboZIP interface, although it is generally only useful when creating a ZIP as a result
of a Auto Backup Set where files are defined. The options that affect the user interface when creating archives are in 
the Compression User Interface tab of the Archive Options, within the Archive menu.

{button ,AL(`How To',0,`',`')} Other "How To" topics



Frequently Asked Questions

"Fail to Extract Files" message: What do I do with a bad ZIP or other archive file?
With the many variables involved in downloading files, sometimes they become corrupted during the process. 
TurboZIP will attempt to open all archived files, but if an error is encountered, the "Fail to Extract Files" message
indicates a corrupt file. Recovery efforts are so seldom successful, that we suggest you delete the offending file 
and download it again.

Can I send a TurboZIP ZIP file to a friend who doesn't have TurboZIP?
Yes. TurboZIP uses the industry standard ZIP file format, accessible to all other ZIP utilities that adhere to that 
standard. If you are not sure if your friend has a ZIP utility, you can create a Self-Extracting ZIP file that does not
require an unzipping program.

What is a ZIF file?
TurboZIP creates ZIF files as index files for your ZIP Sets. This enables quick viewing of the files, as well as the 
ability to view a listing of their content when the files are on removable media. Their location is specified in the 
Tools | Program Options | Setup | ZIP Set folder menu entry.

How can I make a ZIP file smaller? It won't fit on a floppy diskette.
Highlight the file and choose Recompress from the Archive menu. You may choose a higher compression level 
and recompress the file, which may reduce it sufficiently.

My ZIP file is still too large for a floppy diskette. What can I do?
TurboZIP can create Multi-volume ZIP files, which means a large archive is split into smaller sections so they 
can be saved onto multiple floppy diskettes. If the ZIP file already exists, it will be necessary to recreate it; select
a floppy drive as the location to create it. TurboZIP will automatically split the large file into smaller sections 
provided the "Multi-volume on removable media" box is checked in the Advanced Compression (Archive 
Options) tab under in Archive Options, accessible from the Archive menu.



Toolbar

New ZIP opens the Add Wizard, so you can specify choose and name and the files for your new ZIP file.
Open accesses a standard file dialog and lets you open an existing ZIP, self-extracting exe, tar, uuencoded, etc., 

file. Click on Files of type: to choose which file extension(s) to show in the file list.

 The Arrow next to the Open button lets you choose from the most recent files opened in TurboZIP.
Delete erases the selected file from your hard drive and the ZIP Set listing (depending on options, the file may be 

retrieved from the Recycle Bin). 
Remove will remove the selected file from the list in the TurboZIP ZIP Set window. 
Add will open the Add Wizard, so you may add new files to the archive currently selected.
Extract opens the Extract Wizard so you may proceed with the steps to open the archive.    
Subfolder toggles the display of any subfolders that are present in archive files. When activated, any files with 

archives will be marked with the plus (+) symbol and can be expanded; only files in the highlighted folder are 
shown in the File List pane. If inactive, all files in the archive are displayed in the File List pane, with folder 
names, if any, shown in the last column of the Details view.

Maximize opens the View window to full size, temporarily covering the remaining two windows, until you click on 
the button again.      

Options accesses the TurboZIP tabbed Archive Options dialog.

 A right-click on the toolbar, or the Toolbar item under the Preview item in the View menu lets you change the 
position and look of the TurboZIP toolbar to your preference. 



File Menu

New  leads to entries for creating a ZIP, ARJ, or LHA archive. A file dialog will then allow you to name the file, 
followed by the Add Wizard, for choosing the content and specifications for your new archive.

Open accesses a standard file dialog and lets you open an existing files from the extensive list of supported archive 
and email formats. Click on Files of type: to choose which file extension(s) to show in the file list.

Auto Backup Script  gives the choice of New or Edit, to begin the creation of an Auto Backup Script or edit and 
existing one. 

 Refer to How To Create and Use Auto Backup Scripts for further details on this convenience.
ZIP Set  offers two choices:

New creates a new entry in the ZIP Set window, with the name "New ZIP Set." Overtype the name with your 
own selection, or select it and use the Rename Item menu entry at a later time.
Sync ZIP Set verifies that the files listed in your ZIP Set are still present on your computer. Files that have been 
deleted through other means are removed from the ZIP Set. Files in ZIP Sets that reside on removable media 
that are not currently present will also be removed, so care should be exercised when applying this feature.

 Refer to How To Create and Use ZIP Sets for further details on this feature.
Copy To opens a file dialog, where you can specify the drive and folder location to which you would like to copy 

the currently selected file. The original file remains in its current location.
Move To opens a file dialog, where you can specify the drive and folder location to which you would like to move 

the currently selected file. The original file will be deleted after it is moved to its new location.
Send Mail will automatically attached the selected archive file as an e-mail attachment of an outgoing e-mail in 

your e-mail client. (Requires that MAPI be installed.)
Remove will remove the selected file or ZIP Set from the listing in the TurboZIP window.
Delete erases the selected archive or the selected files inside the archive file from your hard drive (depending on 

options, the file may be retrieved from the Recycle Bin).    A confirmation dialog is shown prior to deletion.
Rename allows you to edit or replace the name of the currently selected file, ZIP Set or the selected files inside 

the ZIP file. Slowly clicking twice on any file name will also access the rename function, just as in Windows 
Explorer.

Change Properties opens the Change Properties dialog, where you can change the date, time, and file attributes 
of the currently selected archive or e-mail files.    You can also change the date, time, and file attributes of the 
selected files inside the ZIP file.

Archive Properties displays a list of useful information about the archive. Any ZIP Comment, if one is included, is 
displayed, and you can key in a comment and save it by clicking the Set Comment button.

Close exits TurboZIP or retains it for use depending on the Tray Icon option chosen in the Tools Menu. 
If Tray Icon is checked, Close removes the TurboZIP window from view, but does not close the program; it 
remains active and available from the icon in the system tray. This action enables TurboZIP to be immediately 
available when needed.
If Tray Icon is unchecked, TurboZIP is completed closed, and it will be necessary to reopen the program when 
needed.

Exit closes TurboZIP and removes it from memory; the program will need to be reopened if needed.

 Most of these File Menu items can also be accessed by right-clicking on a file, or in the file list window.



Archive Menu

Add will open the Add Wizard, so you may add new files to the archive currently selected.
Extract opens the Extract Wizard so you may proceed with the steps to open the archive.    
Auto Backup opens an Auto Backup Script ABS file of your choice, in order to create a backup archive. If the 
currently selected ZIP file is the target of an Auto Backup Script ABS file, Auto Backup will open the associated 
ABS file.
Test ZIP displays a Test dialog and indicates if the file is OK, has a Bad CRC, uses an Unknown Compression 

method, is Password protected, or has another Error.
Select All highlights all the file names in the archive file currently selected.
Recompress ZIP opens a compression level dialog. This allows you to compress the file again, using a higher or 

lower compression level (0-9). 

 If the size of a ZIP file is particularly critical, such as those which must fit on a removable disk, 
recompressing the ZIP using higher levels of compression may be helpful.

Print File List Preview displays a preview with a WYSIWYG (What You See Is What You Get) view of the printout
that will be produced if the Print File List (the next menu item) command is executed. A buttonbar is available to 
change the view and print the page. 

Print File List prints a list of archive files, if a ZIP Set is highlighted, or a list of files within an archive, if a single 
archive file is highlighted.        

The display is a direct reflection of the File List pane in TurboZIP. Therefore, resizing columns and 
rearranging them (available if Internet Explorer 4.0 is installed) by dragging them left or right will affect the 
preview and printout.

Options opens the Archive Options , six tabs with selections that affect the manner in which TurboZIP operates.



View Menu

Toolbar - when checked, the TurboZIP toolbar is shown. Select and deselect this option by clicking on it.
Status Bar - when checked, the TurboZIP status bar is shown at the bottom of the window, which displays 

information about the currently selected file. Select and deselect this option by clicking on it.
Preview Pane - the preview pane, where the content of selected files is shown, can be positioned below or 

adjacent to the file list using this option's Horizontal or Vertical selection, or hidden from view by selecting None.
Resize Column Widths - when the Details item is checked in this menu (View), you may resize the columns by 

placing your cursor on any column heading junction until your cursor turns into a double arrow, and moving to 
size. When Resize Column Widths is clicked, the column widths will be reset to the default widths.

SubFolders - the ZIP Set listing pane (on the left), by default, displays a list of files. If the SubFolders option is 
checked off, any archives with folders will be marked with the plus (+) symbol and can be expanded; only files in
the highlighted folder are shown in the File List pane. If inactive, all files in the archive are displayed in the File 
List pane, with folder names, if any, shown in the last column of the Details view.

Large Icons, Small Icons, List, Details - choose the way you'd like to display files in the File List pane, so they 
are represented by icons, file names, or complete details.

Arrange Icons - select from a list of over a dozen different file criteria by which to sort your icons or file list.

 Lists can also be sorted by clicking on any column heading, making it the sort criteria; repeated clicking 
makes the order ascending or descending.

Refresh - this selection reloads the selected archive or e-mail file.



Tools Menu

Find in Files - TurboZIP offers a powerful search mechanism that can search files within archives. For complete 
details on this flexible system, review the Find in Files help topic.

Show Found Files - After the Find in Files function has located files and the window closed, this menu item can 
recall the list for your reuse.

Make Self-Extractor - Select a ZIP file and click on this menu item to begin the process to Make a Self-Extracting 
EXE File.

UU Encode File (Make) - This menu item starts the process of creating a UU Encoded file for E-Mail purposes. 
Details on the Create UUEncoded File window and instructions on How to E-Mail UU Encoded files are included
in this help file.

Auto Scan - add files to ZIP Sets automatically from targeted folder(s) and by selected extension(s). Consult the 
Auto Scan topic for details on this useful feature.

Virus Scan - click on virus scan to use your favorite virus scanning program to scan the highlighted archive or 
individual file for viruses. If no scanner is configured, the Virus Scan Program Options window will be displayed, 
so you can provide the necessary input. You can change a currently configured virus scanner by clicking on the 
Tools|Program Options menu item.

Fix Explorer Associations - by default, TurboZIP creates an association on your system to files with all of the 
supported archive and email formats, so when you double click on one, TurboZIP will automatically be opened 
for you. Sometimes, other programs installed after TurboZIP was installed may change that convenient 
relationship. If you would like TurboZIP to be your choice when working with these files, click on this menu entry.
If it is grayed out, that means the associations are intact and do not need to be restored.

Tray Icon - This option setting controls how TurboZIP behaves when you close it using different methods:
If Tray Icon is checked, the File|Close menu item removes the TurboZIP window from view, but does not close 
the program; it remains active and available from the icon in the system tray. This action enables TurboZIP to be
immediately available when needed. The File|Exit menu item will, however, completely close TurboZIP.
If Tray Icon is unchecked, TurboZIP is closed by any conventional Windows close command, and it will be 
necessary to reopen the program when needed.

Start Menu Icon - click on this menu item to create a convenient TurboZIP entry on your Start Menu.
Desktop Icon - selecting this entry will add an icon for quick access to TurboZIP on your Desktop
Toolbar  - click to access toolbar choices:

Button Text - click to toggle the use of text and large icons in the toolbar, or select the small icon buttons.
Align… - click on your choice to locate the toolbar on the left, right, top, bottom of the TurboZIP window.

 These options can be quickly accessed by right clicking on the toolbar.
Preview Filters - access the file extensions and their associations to TurboZIP filters that are used for the view 

function. Details on the Configure Filters function and how it impacts TurboZIP operations are included in the 
help topic for each screen.

Program Options - click to access the Setup, Preview, Auto Scan, Virus Scan and External Program option 
screens, in a tabbed format. Click on any of the choices above for further details on their content.



Preview Menu

Preview Toolbar - when checked, the various toolbars that support the Preview Pane are enabled. When 
unchecked, the window has slightly more room available for display, and right mouse menus remain available to
access toolbar functions.

Stop Preview - click (or use the Ctrl-Shift-S shortcut) to disable previewing of the selected file.
Reload Preview - click (or use the Ctrl-Shift-R shortcut) to reload the subject file or file list.
Use ActiveMovie - when checked, ActiveMovie is used for viewing multimedia files. Refer to the help topic About 

ActiveMovie for details and recommendations for use.
Use ActiveX - when checked, ActiveX is used for previewing and interacting with any applicable file. Refer to the 

help topic About ActiveX for details and recommendations for use.
Increase Font Size - toggle the font size to the next larger size.
Decrease Font Size - toggle the font size to the next larger size.
Find - this menu item opens the Find dialog box that allows you to search the opened file for text, with various 

options including case sensitivity and fuzzy (approximate match) searches. Click on Find dialog box for further 
details. 



About ActiveX and ActiveMovie

The ActiveX and ActiveMovie technologies are specialized components from Microsoft, generally supplied as a 
part of other applications and designed to be used with programs that are able to utilize their components. It is a 
descendant from OLE technology.
TurboZIP is able to use these services to more accurately display files; as well-constructed as the various filters 
are, the ActiveX technology shares parts of the actual application with TurboZIP.

Advantages to using ActiveX and ActiveMovie
More accurate view of files; for instance, Microsoft Word files will be shown as text if ActiveX is not enabled. When
enabled, the application displays the file in detail, or even in a different format. As an example, the TurboZIP filter 
will show the text source of an HTML file, but if Internet Explorer is installed and ActiveX chosen, an HTML file will 
be displayed as if it were being viewed in the browser.
Automatic updating of filters; if a new version is released, with a different file format, ActiveX will also be updated, 
so the new format file can be displayed. A good example would be new HTML codes that are added to the next 
version of Internet Explorer.
Companies besides Microsoft have added ActiveX support to their products, and more continue. As an example, 
Adobe Acrobat PDF and AutoDesk DWF are two recent additions.

Disadvantages to using ActiveX and ActiveMovie
It can be slower than using a TurboZIP native filter.
ActiveX previews will only be effective if the applicable component objects have been installed. As an example, if 
Excel has not been installed, the ActiveX preview will likely not work, or may only deliver a partial view; use the 
TurboZIP (ActiveX unchecked) instead.

See also Preview Pane 



Command Line Parameters

These commands can cause TurboZIP to perform specified tasks, and can be useful when used in conjunction 
with scheduling, macro, and similar programs. 
Each command should be preceded by turbozip.exe and a space. The following is sample syntax for the 
command line to create a ZIP using an Auto Backup Script (abs) file:
C:\Program Files\TurboZIP3\turbozip.exe /O "C:\ example.abs"

/O Mylist - Open archive and abs (Auto Backup Script)
Mylist is a list of archive files or abs files. Place double quotes (" ") around each file and separate them with one 
space.

/S - Start TurboZIP with autoscan      
This command will use whatever is defined in the Auto Scan Program Options.
/S/I - will use the autoscan folder defined in the Auto Scan Program Options, with the option to scan subfolders.
/S/U - will use the autoscan folder defined in the TurboZIP Auto Scan Program Options, with the option not to 
scan subfolders.
/S(/I or/U) "folder" - the folder specified within the double quotes (" ") will be override the Auto Scan and be 
used as the default Auto Scan folder

/X "folder" Mylist - Extract to Folder    
The first item is the destination folder. Mylist is a list of archive files to be extracted to the folder. Place double 
quotes(" ") around each file item and separate them with one space.

/E Mylist - Extract 
Mylist is a list of archive files to be extracted. Place double quotes (" ") around each file item and separate them 
with one space. The destination folder is depended upon the Archive options

/A Mylist - Add or create a new zip
Mylist is a list of file to be added into an unknown zip file. Place double quotes (" ") around each file item and 
separate them with one space.

/U "zip file" Mylist - Update a zip file
The first item is the zip file. Mylist is a list of file to be added into the zip file. Place double quotes (" ") around 
each file item and separate them with one space.

See also Create and Use Auto Backup Scripts (How To) 



Drag and Drop Operations

Drag and Drop operations can be carried out from Turbo Browser or Windows Explorer, or from within TurboZIP 
itself.

Add file(s) to an existing ZIP archive

 Drag one or more files to a ZIP archive; TurboZIP will open to the Add Wizard: Select Destination Archive and 
Items to Add dialog so you can immediately continue the process of adding the file(s) to the existing archive.

 to 

 Drag one or more files to a ZIP archive in the TurboZIP ZIP Set listing (left pane; TurboZIP will open to the Add 
Wizard: Select Destination Archive and Items to Add dialog so you can immediately continue the process of adding 
the file(s) to the existing archive.

Extract files from a ZIP archive:

 to 

 Highlight the file in TurboZIP so the file list is in the File List pane. Drag and drop one or more files to Turbo 
Browser or Windows Explorer.

 Use your right mouse button to drag an archive to a folder; a right-click menu will appear and allow you to 
choose to extract the file using TurboZIP.

Copy files from TurboZIP to TurboBrowser or Explorer

 to 

 Highlight a ZIP Set so its content is shown in the File List pane. Highlight one or more archives in the File List 
pane and drag them to TurboBrowser or Windows Explorer to copy them to that location.

Copy files from one archive to another in TurboZIP

 Highlight a file in the ZIP Set pane, and then select the file(s) in the File List pane to be copied. Then, drag the 
files to the destination ZIP file in the ZIP Set pane.

Move Files between ZIP Sets

 Drag the file from its current location to the ZIP Set folder title. Multiple files can be moved by highlighting a ZIP 
Set and using standard file selection methods to choose files from the File List pane, which can then be dragged to 
the desired ZIP Set.

 



Multiple File Operations

The multithreading technology used by TurboZIP enables the system to accomplish more than one operation at 
the same time.    This ability, combined with the features built into the system, enable you to:
Extract multiple files by highlighting as many supported archive and email files as you wish, using standard file 

selection methods in TurboBrowser or Windows Explorer. Choose the Extract with TurboZIP item from the right 
click menu.
Extract multiple files by highlighting selections wish, using standard file selection methods in the TurboZIP File
List pane and selecting Extract.

 In both cases, the default condition is to allow you to review and authorize each extraction by displaying the
TurboZIP dialog. However, to speed the operation, check off the No user interface is displayed for extracting 
files option in the Extraction Folder tab under Archive Options. This will bypass the interface and speed the 
operation.

Open multiple files using the same opportunities presented above, except choose the Open menu item.
Begin another archiving or unarchiving process while another, such as unzipping an exceptionally large file, 

goes on in the background.



Password and Encryption Notes

When passwords (file encryption) are applied, they are not assigned to the ZIP archive itself, but to individual files 
within it. Therefore, individual files can be encrypted, or not, and individual files can have different passwords for 
accessing them. 
When the password option is used, it applies to each of the specific individual files shown in the file window of the 
Add Wizard: Select Destination Archive and Items to Add. dialog. 
It is important to note the following distinction:

If it is a new ZIP, then all files are encrypted
If new files are being added to an existing ZIP, the files currently in the archive retain their present 
characteristics; if they are not encrypted, they remain so, and if they are currently password protected, they 
keep that protection.

To add multiple, different passwords to different files, and to add files without encryption, it is necessary to run the 
Add to ZIP function multiple times, creating a new ZIP, and then adding new files with or without passwords as you
desire.

Why would I want to have different passwords for different files?
A good example would be a single ZIP file that is distributed to a group of people, but includes files suitable only 
for specific individuals in the group. A specific use could be sales reports, where individuals could view their own 
data only, yet group managers could view all their salespersons' figures. Each group of files could be assigned its 
own specific password, and those intended for the entire group could remain unencrypted. Then, depending on 
their need, individuals would be given one or more password(s) that would allow them access only to the files they
are permitted to view. 

    The encryption provided in TurboSFX is the standard PKWare® 2.04g Encryption.



Preview Pane

As you click on files within an archive they are displayed in the Preview Pane if the Stop Preview option in the 
Preview menu is unchecked. The section can be positioned below or adjacent to the File List using the Preview 
Pane item in the View menu, choosing the Horizontal or Vertical selection, or hiding it from view by selecting None.
The Preview Pane will change in appearance depending on the type of file chosen, with different toolbars and right
mouse menus. Intuitive icons are provided, and a description will appear as you float your cursor over each button.
Over 100 of the most popular file formats are supported, and with options for configuring the filters, combined with 
ActiveX compatibility, the feature could accommodate a virtually unlimited number of file types. 
Please review the section about ActiveX and ActiveMovie for information on selecting or deselecting those options 
for best results.
Toolbars and menu options will differ from the descriptions below if ActiveX and/or ActiveMovie are 
enabled. This documentation describes the default TurboZIP toolbars and menus.

 Preview Pane toolbars can be hidden by unchecking the Preview Toolbar entry under the Preview menu. This 
increases the available space for image previews; the Preview Pane right-click, context-sensitive menus include the 
same content as the toolbars, along with additional options.

Image Files are displayed, and features are made available for you to manipulate your view:
The toolbar and menu include zoom, undo, select area, rotate, and reload buttons. Changes are made to your 
view only, and do not affect the file. Additional right-click menu choices for printing and copying individual frames
are available.

Clipart Files offer no toolbar, but print, copy, and other options are available from the right-click menu.
Multimedia files (video and sound) are shown or played, and controls provided to start, pause, and stop 

playback. Additional right-click menu choices for printing, cropping, etc., are available.
Text Files are will display as plain text or formatted, depending on the type. Their unique toolbar and menu items 

help to navigate and even search the file. Functions include find , find next, move to top or bottom of the file, 
word wrap, and font size buttons. The right click menu, in addition to duplicating the toolbar functions, has 
entries to open the application to which the file is associated, print, and print through the application to which the
file is associated. Highlighted portions of the file can be copied to the clipboard.

Spreadsheets are displayed in a grid format, and multiple sheets are supported. Other functions include find , 
prior or next sheet, and font size buttons. The right-click menu, in addition to duplicating the toolbar functions, 
has entries to open the application to which the file is associated, print, and print through the application to 
which the file is associated. Highlighted portions of the file can be copied to the clipboard, and the file displayed 
in hexadecimal format.

 Notes:
While TurboZIP has the convenient Preview feature, you can also launch executable and files (which will be 
opened in their associated applications) by double-clicking on them. However, it is far quicker to preview files 
within TurboZIP.
Control-Shift-M is the keyboard shortcut to toggle the Preview Pane to the full size of the TurboZIP window. 
Please review the section about ActiveX and ActiveMovie for information on selecting or deselecting those 
options for best results.

Supported File Formats (preview):

Partial List of Archive and Email Formats Supported:
Archive: ZIP, CAB, EXE, LHA (LZH), ARJ, GZIP (GZ), Z, TAR, TAZ, TGZ
Email Attachments: MIME Encode (MME), UU Encode (UUE), Binhex (BHX, HQX), Internet E-Mail (EML), 
CompuServe E-Mail (PLX)

Partial List of File Viewing Formats Supported:
Document & Text Files: Text Files, MS Word, WordPad, MS Works, (Adobe Acrobat) PDF, Word Perfect, Ami 
Pro, HTML, ASCII, Text, Windows Help, and TTF, FON font formats



Graphic and Presentation Formats: ANI, BMP, CGM, CLP, (CorelDRAW) CMX, CUR, CWD, DIB, (AutoCAD) 
DWG, DXF, and DWF, EMF, GIF, ICO, JPEG, (Live Picture) FPX, (Kodak) Photo CD, PCX, PICT, RLE, TARGA, 
TIFF, WPG, WMF, (PowerPoint) PPT and POT
Multimedia Files: (including full-motion) AVI, FLC/FLI, MPEG and MP3 (DirectX 6.0), QuickTime (MOV, Driver 
required), MIDI, and WAV
Spreadsheet and Database: Excel, MS Works, Lotus 123, Quattro Pro, dBase, FoxPro
ActiveX and ActiveMovie: defined by the application components installed with the program

 File formats are directed to specific filters by TurboZIP so they can be displayed properly. Those associations 
can be reviewed and edited; see Configure Filters (preview associations) for additional documentation.



Supported Archive and E-Mail Formats (open and extract):

arj ARJ archives
b64 MIME e-mail
bhx, hqx Mac BinHex
cab CABinet archives
exe Self-Extracting ZIP files
gz Unix Z archives
lzh LHA archives
Mme,mim MIME e-mail
tar UNIX TAR archives
taz, tgz UNIX Z archives
Uue, uu UU Encoded e-mail
zip ZIP archives
z UNIX Z archives

Shortcut Keys

TurboZIP offers keyboard shortcuts for many commands, for quicker access and to avoid mouse use. While menu 
entries display their equivalent keyboard shortcut, the following list is provided for your reference.

 Click to Print this listing; it has been arranged so it could easily be cut out and referenced for your convenience.

File menu View menu
New ZIP Ctrl+N Resize Column Widths Ctrl+W
Open Ctrl+O Show Subfolders Ctrl+H
Copy to F8 Preview Pane - None Ctrl+Shft+N
Move to F7 Vertical Ctrl+Shft+V
New ZIP Set Ctrl+Shft+Z Horizontal Ctrl+Shft+H
Remove ZIP Set Del Maximize Ctrl+Shft+M
Delete Ctrl+Del
Rename F2 Tools menu
Archive Properties Alt-Enter Find in Files F3

Show Found Files F4
Archive menu
Add Insert Preview menu
Extract Ctrl+E Stop Preview Ctrl+Shft+S
Auto Backup Ctrl+B Reload Preview Ctrl+Shft+R
Test ZIP Ctrl+T Find Ctrl+Shft+F3
Print File List Ctrl+P
Select All Ctrl+A
Refresh F5
Options Ctrl+Shft+O Help (context sensitive) F1

Archive Properties



This dialog is accessed from the File Menu, Archive Properties, or from the right-click menu.
This dialog displays a number of archive property values that you may find informative and helpful.
The Comment is displayed, if applicable. A ZIP comment may be added or edited, and saved by clicking on the 
Set Comment button.



Auto Scan
This dialog is accessed from the Tools Menu, Auto Scan.
Auto Scan, accessible from the Tools menu, is a convenient tool for adding files to ZIP Sets. You can choose 
folder(s) to scan and select specific type(s) of files to include. To be sure that files you choose are placed in the 
ZIP Set you want, be certain that the ZIP Set or a file within it is highlighted before choosing Auto Scan from the 
menu.

Enter a folder name for Auto Scan to look in:
Key in a folder name or use the Browse button to navigate to your choice.

Enter or add file types for Auto Scan to search:
Key in file types, such as *.zip, separated by semi-colons, or use the convenient drop down box to the right; 
making your choices from that location automatically adds them to the list

 Scan subfolders
Check off this box to include files within subfolders beneath the selected folder name. If left blank, only files in 
the selected folder will be included.



Change Properties
This dialog is accessed from the File Menu, Change Properties, or from the right-click menu.
Date: and Time: - enter the desired date in time in the format shown, or click the Current Date/Time button to 
insert the current date and time, which can then be modified.
Attributes - check off any attribute you wish applied to the file and uncheck those you wish removed.



Select Destination Folder (Extract Wizard)
This dialog is displayed when the Extract function is chosen.
Extract… (displays the path and file name of the archive chosen for extraction)
To: - enter or browse for a folder to put the files. If you enter a folder that doesn’t already exist, TurboZIP will 

create it. 
Enter decryption code (if necessary) - if file(s) within the ZIP are encrypted (password protected), you can enter 

the decryption code in the space provided and click the  Use this code for all files: check box.

 If no code is entered and the file is encrypted, you will be prompted for each file that requires a password, with the 
option to skip the file or apply the password to all files.

Configure - click this button to access the Archive Options - Extraction option window, for overwrite and other 
extraction options, if checking the state of these options is necessary.

 Changes you may make through the Configuration button apply to this archive only; to make changes to any 
TurboZIP default settings, access Archive Options from the Archive menu entry.

Click on Finish to extract all the files from within the ZIP file.



Create UUEncoded File
This dialog is accessed from the Tools Menu, UUEncoded File.
This function is for creating a file that can be included in an E-Mail message. You may refer to the How to E-Mail 
UU Encoded files topic for some additional information on their usage.
You can first highlight an archive from the ZIP Set window, or later select any file from within this dialog. There can
be advantages to archiving a file before UUencoding and sending it.

Enter UUE file name
The file name is pre-entered in this box based on your file selection, with the file extension .uue substituted for 
the original extension. Type or use the browse button to edit the selection if necessary.

Type in message
An unencoded message can be included with the UU Encoded file. Type the text in the block provided, or paste 
in text using any Windows paste methods (Shift-Insert). The text message is limited to 4999 characters.

Enter the attachment file name
The file name is pre-entered in this box based on your file selection. You may type or use the browse button to 
edit the selection to choose another file, if desired.

 It is not necessary to select a ZIP or other archive for UUEncoding, although there is generally a benefit for doing 
so. Files of any type can be opened using TurboZIP by selected All Files under Files of type in the Open File dialog. 
As well, the file can be selected using the Enter the attachment file name as mentioned above.
There are benefits to be gained by making a ZIP file and UUEncoding it rather than processing the original file. The 
ZIP archive will generally be significantly smaller than the original, which contributes to faster file transfers and less 
disk space. ZIP files use internal file checking, so it will be more evident to the recipient if the file was corrupted 
during transfer. Finally, multiple files can be combined into one ZIP archive, if desired.

 If you are unsure that the receiver of the file has a ZIP utility, create a self-extracting ZIP file and UUEncode it.

Why is it necessary to Uuencode files before emailing them?
E-Mail is designed to send the main set of ASCII characters that make up the alphabet, numbers, and a limited 
number of special characters. Binary files (for example: images, ZIP archives, programs) use additional characters
that E-Mail cannot accept. Therefore, files are converted to the UUE format, which only uses the allowable 
characters, so the otherwise non-e-mailable files can be sent.



Find
This dialog is accessed from the Preview menu, Find, and from the right mouse menu and toolbar in the Preview Pane. 
This Find dialog and function is for locating text and text strings within a selected file within an archive. Another 
TurboZIP function, Find in Files, is designed to search multiple files. Refer to How To    Find Files and Information 
Inside Files for details on both functions.
Containing text: - enter your text here, or use the arrow to choose from previous entries 
 Match whole word - select to ignore partial matches, such as when your selection could be a part of another 

word, such as selecting 'multiple' when 'tip' is your search criteria.
 Case sensitive - choose this option to ignore anything that does not match the case of your entry
 Search textual parts of files only - ignore non-text portions of files. Choose this option to search the comment in 

the ZIP file or the message portions of e-mail files.
 Exact match - results are returned based on a precise match with your input.
 Best match - if no exact matches are found, use "fuzzy search" capabilities and return near-matches. This feature 

is ideal when you are uncertain of spelling or precise expressions.

See also How To Find Files and Information Inside Files 



Find in Files
This dialog is accessed from the Tools Menu, Find in Files.
This powerful TurboZIP feature can search within the content of files inside unopened archive and encoded email 
files. Highlight a file or ZIP Set, and then specify the scope from the three options offered, and explained in the 
next paragraph. 

Scope
File Type - enter a file mask, such as *.txt or *.doc, for example, to restrict your search to a particular type of file.
The default *.* includes all files.

 Selected file (default) - the search is restricted to the file that is currently highlighted. This option will not be 
available if a file was not highlighted before clicking on the menu entry.

 Current ZIP Set - the entire ZIP Set that is highlighted, or that the highlighted file is part of, is included in the 
search.

 All ZIP Sets - the entire collection of ZIP sets is searched when this option is selected.

Date
 All dates (default) - no files are excluded by date.
 File files created or modified between… and - enter or use the buttons to select a beginning and ending date, 

and exclude any files created or modified before or after those dates.

Attributes
 All attributes (default) - all files are included.
 Find files with the selected attributes - check off attributes that you want to include in your search.

Size
 All sizes (default) - include all files of all sizes.

 Find file size in the range - key in a file size and select from bytes, KB, MB, or GB, to further define the size. 
Then select from Below (equal to and less than), Above (equal to and greater than), or an exact match.

Content
Containing text - enter a text string, or recall a recently used text string from the down arrow button.

 Match whole word - select to ignore partial matches, such as when your selection could be a part of another 
word, such as selecting 'multiple' when 'tip' is your search criteria.

 Case sensitive - check off to select text only if the upper and lower case patterns match your input.

 Search textual parts of files only - restrict the search to the portions of files that contain text. Choose this 
option to search the comment in the ZIP file or the message portions of e-mail files.

 Exact match - results are returned based on a precise match to your input.

 Best match - TurboZIP will use "fuzzy search" criteria to return findings that are close, but not exactly matching 
your input. This is a useful option when the exact text string is not known.

See also How To Find Files and Information Inside Files



Find Results
This dialog appears as a result of using the Find In Files selection under the Tools Menu.
The title bar of the dialog and the bottom window describe the search criteria chosen in the Find dialog, which is 
used to define filters used to get the results you need.
The upper window lists the files and the archive in which the each were found.
Two buttons are provided at the top of the window. The first will display the content of a selected file in the preview
window. The second will extract the selected file to the folder of your choice.

 See the How To Find Files and Information Inside Files for further details and a useful example.



Make Self-Extracting EXE File
This dialog is accessed from the Tools Menu, Make Self Extractor...
Enter a self-extracting file name - The current file path and name will automatically be entered, replacing the ZIP
extension with EXE. Accept this fine name, key in or modify the file name and path, or use the Browse button.
Select a program to run automatically after self-extraction - A file can be run by the self-extracting executable 
after it has been extracted. Enter or use the arrow button to select from a list of file names within the self-extractor.
Type in your message (256 char. max) or browse for a text file name - A message can be displayed when the 
self-executable is first run. Key in a message or browse for an ASCII text file. If a file exceeding the limitation is 
selected, it will be truncated in order to meet the character limit. 
The Self-Extracting EXE file created by TurboZIP is a 16-bit executable and is fully compatible with Windows 3.1, 
95, 98, and NT.

 TurboSFX, another product from Pacific Gold Coast Corp. is available for more demanding needs for custom 
self-extracting EXE and Installer files.

TurboZIP Self-Extracting (EXE) ZIP File - Extraction Dialog
The following information and options apply to the Self-Extracting ZIP file dialog that appears when a file that 
TurboZIP creates is executed. These instructions are displayed when the Help button in the extract dialog is 
clicked:
Destination folder - the folder where the self-executable resides is automatically entered. Edit, key in, or use the 

Browse button to change it.
File list box - the files within the self-executable are shown in the selection. If untouched, all will be extracted. 

Individual files and groups can be chosen using standard file selection methods, so that only they are extracted. 
Restore path names - paths will not be restored unless this check box is selected; however, consider that paths 

must have been present in the original ZIP file in order to be restored.
Decryption code - if file(s) within the self-executable are password protected, enter the decryption code in this 

box.
Overwrite confirmation - by default, the self-extractor will overwrite any files with the same name. Select this 

option to receive a message box asking for confirmation to overwrite an existing file.



Multi-Volume Options
This dialog is displayed when a removable disk is selected as the location for a new ZIP file.
When a removable disk is specified as the target for a ZIP file, TurboZIP prepares for the possibility that the 
archive may exceed the size of the media and may require multiple diskettes. The Multi-Volume Options dialog 
allows you to choose how it will treat the diskette that is inserted. The last disk of a multiple volume set contains 
the content information of the set.

 Keep existing files will not overwrite files on the target media, and will size volumes to the free space available 
on the drive.

 Delete existing files erases all files on the target, to allow the use of the full capacity of the removable media.

 Format disk performs a complete format of the target diskette.

Caution! Once a multiple volume set is created, you may not modify it.



Print Image
This dialog is accessed from Print in the right mouse menu in the Preview Pane.

 Best fit automatically sizes the image for the best fit on the page.

 Stretch to page will enlarge the image to the size of the display pane.

 Margins allows you to select placement on the page by entering margins for top, bottom, left, and right.

 Scale enlarges the X or Y axis based on the whole number settings you enter.

 Print headers adds the date, file name, and page number to the top of the page.
Copies can be incremented to your quantity requirement.
Driver Setup accesses the Print Setup dialog, so the printer, properties, and paper orientation specified.

See also How To Print Files and File Lists 



Print Preview
This dialog appears as a result of using the Print File List Preview selection under the Archive Menu.
The requested report is displayed for your inspection by this dialog.
You may use the toolbar buttons to Print the report, use the Next Page and Previous Page buttons to browse it, 
get a Two Page view or Zoom In or Zoom Out to change viewing preferences. Finally, the Close button returns 
you to the TurboZIP main window.

 The display is a direct reflection of the File List pane in TurboZIP. Therefore, resizing columns and rearranging 
them (available if Internet Explorer 4.0 is installed) by dragging them left or right will affect the preview and printout.



Print Spreadsheet
This dialog appears when a spreadsheet file in the Preview Pane is chosen to be printed using the right click menu.
Print range

 All - prints the entire spreadsheet file.

 Sheet number - prints only the selected sheet.

 Print headers - checking this option adds a header to each page with the date, file name, and page number.
Copies - enter the number of copies required.
Driver Setup - accesses the Windows Print dialog, so the printer and printer properties can be accessed.



Print Text
This dialog appears when a text file in the Preview Pane is chosen to be printed using the right click menu.
Font type - choose from fixed width (monospaced) fonts available on your computer.
Tab length - select 4 or 8 fixed spaces for tabs.
Paper Size - click the radio buttons to choose from the standard paper sizes offered, Letter (8.5x11 inches) or A4
Layout - These options let you select the format of the text output and page orientation. The final selection is 

useful for conserving paper.

 One page per sheet (Portrait)

 One page per sheet (Landscape) 

 Two pages per sheet (Landscape) 

 Draft output - sends raw, unformatted output to your printer, and disables the other options.

 Print headers - checking this option adds a header to each page with the date, file name, and page number.

 Use ActiveX - this option is available only for HTML files; when checked, it prints HTML in the web page format. 
When unchecked, the HTML text source is printed.

Copies - enter the number of copies required.
Driver Setup - accesses the Windows Print dialog, so the printer and printer properties can be accessed.



Test
 This dialog is accessed by highlighting a ZIP file and selecting Test ZIP from the Archive menu entry.
The Test dialog displays the Name and Status of each file in a ZIP archive. Possible status conditions are OK, 
Bad CRC, Unknown Compression method, Error, and Password protected. The File Name is shown at the top of 
the window.

 Corrupt archives can seldom be repaired. Re-downloading or otherwise reacquiring the file is generally the best 
bet.



Select Destination Archive and Items to Add (Add Wizard)
This dialog is accessed when creating a new ZIP, ARJ, or LHA archive or adding files to an existing archive.
Type in a destination archive - enter a file name or use the button to open a file window to browse for an existing
ZIP file. 
Browse button - click to open a file window, and browse to locate and choose files to add to your ZIP file. You can
use standard file selection methods to pick the files you want. Wildcard selection criteria, such as *.* or xyz?.doc, 
can also be used.

 After selecting files from one location, you can click the Browse button again, to add more files from the same or 
different folders.
Remove button - click on any item(s) in the window using the standard file selection method to remove them from 
the files to be added.
Window - this area displays a list of files selected to add to the ZIP file. If you have chosen an existing file, it does not
display those files already in the archive.

 Add comment or password protect the items - check off this box to add a comment or password protection. If
checked, the Set Comment and Password wizard window will be presented next. When adding files to an existing ZIP
that already includes a comment and/or a password, a message will appear and this option will automatically be 
checked off so the comment may be reviewed and edited in the step that follows.
 



Hold down the Control Key to
click on individual files, to add
to your selections.
Hold down the Shift Key to
select a range of files, clicking
on the first, then the last.



Set Comment and Password (Add Wizard)
This screen only appears if the Include Comment or Password in the ZIP option is checked off in the Add Wizard: Select 
Destination Archive and Items to Add dialog. The LHA or ARJ archive formats do not accommodate comments or passwords..

Would you like to add or change the comment?        

 No, thank you disables the option.

 Yes, please makes the area below available for you to add your comment. 
If a comment already exists in a ZIP archive to which you are adding files, it will appear in the comment area. It can 
be edited or left intact.

Would you like to password protect the archive?

 No, thank you will cause the files you are currently adding to remain unencrypted. Any encrypted files in an 
existing ZIP will remain encrypted.

 Yes, please makes the area below available to enter your password; only those files currently being added will 
be encrypted with the password you enter.
If files contained within an existing ZIP archive, to which you are adding files, are password protected, a message 
appears alerting you of that fact. 

    Please see the Password and Encryption Notes topic for additional, important information about the use of 
encrypted files in ZIP archives.



Review (Add Wizard)
This dialog is the last step in the sequence of creating a new archive or adding files to an existing archive.
Window - this are displays a list of options that will apply to the ZIP file, for your review. The Configure button, 

below, allows you to make changes.
Configure button - make changes, or review Archive Options tabs (Compression, Advanced Compression, 

Compression Filters, Auto Backup) by clicking on this button.

 Changes you may make through the Configuration button apply to this archive only; to make changes to 
any TurboZIP default settings, access Archive Options from the Archive menu entry.

When you are satisfied with your options, click on the Finish button to build your ZIP file.



Archive Options
This dialog is accessed from the Archive Menu, Options.
This tabbed dialog lets you access up to six different option categories:
Compression 
Advanced Compression 
Compression Filters 
Compression User Interface 
Extraction 
Extraction Folder 
Auto Backup 

{button ,AL(`options',0,`',`')} Other options



Advanced Compression (Archive Options)
This dialog is accessed from the Archive Menu, Options.
The entries shown all apply to ZIP archives; options that do not apply to ARJ or LHA archives are grayed out in the
dialog when those files are being created.
Options

 Store long file names - if not chosen, files will be truncated.

 Move to ZIP - will delete the source files after they are archived.

 Grow ZIP file - bypasses the safety step of making a temporary file on your drive and creates the file 
immediately.

 Multi-volume on removable media - will result in the creation of a ZIP file that is segmented into multiple, 
smaller files, for storage on removable media, such as diskettes. The output file name in the initial Add to ZIP panel 
must be directed to a removable media drive; if not, a single file will be created.

 Skip over locked files (define) - locked files (in use or otherwise not available) will be skipped.
Subfolder options

 Do not store folder names - includes file names only, without their paths.

 Store all folder names - includes the complete path of the files in your selection.

 Store subfolder names - includes only the relative paths of files included.

 Recurse subfolders - will include the files in the subfolders beneath your selection.
Archive

 Add unarchived files only - will only include files if their archive bit is not on (-a).

 Set added files as archived - will set the archive bit (+a) on files as they are archived.

{button ,AL(`options',0,`',`')} Other options



Auto Backup (Archive Options)
This dialog is accessed from the Archive Menu, Options.

 Silent Auto Backup - When selected, the TurboZIP interface is not shown. This option is useful when Auto 
Backups are being performed using automatic means, such as by scheduling programs.

 Suppress the completion message - When selected, the Auto Backup completion message is not shown. This
option is useful when Auto Backups are being performed using automatic means, such as by scheduling programs.

 Do not insert to ZIP Set - Depending on the state of this option, when archives are created, they will or will not 
automatically be added to the current ZIP Set. It may not be desirable to add backups to ZIP Sets.

 No progress indicator - The progress indicator that displays the course of creating an archive is or is not 
displayed based on the choice in this check box.

 Add date and time to the ZIP file name - This option adds the date and time in parentheses as a part of the 
ZIP file name.

 How To Create and Use Auto Backup Scripts may be a help topic of interest.

{button ,AL(`options',0,`',`')} Other options



Compression (Archive Options)
This dialog is accessed from the Archive Menu, Options.
The entries shown all apply to ZIP archives; options that do not apply to ARJ or LHA archives are grayed out in the
dialog when those files are being created.
Add method - when files are added, one of the following conditions applies:

 Add - will add all the files included in the list box.

 Update - only adds files that are not yet included in the archive and updates those that have changed.

 Freshen - only updates files presently in the archive; if files are included in the list and not already present in the 
archive, they will not be added.

Compression level - choose the compression level (0-9) to be used when creating a ZIP file.
Date filter 

 Only add files modified from - check off this option to exclude files dated before the date shown; click Set 
Today to insert today's date.

{button ,AL(`options',0,`',`')} Other options



Compression Filters (Archive Options)
This dialog is accessed from the Archive Menu, Options.
Compression filters are available to optionally exclude or include particular file types based on the criteria you 
enter. Wildcard formats can be used.

 No file filtering
TurboZIP will include all file types

 Use exclusion filter
Enter file extensions and wildcard to exclude. See example below.

 Use inclusion filter
Enter file extensions and wildcard to include. See example below.

Extensions and wildcard formats must be separated by a semi-colon (;). For example:
*.ext;*.ex2;*.ex3;w*.doc

{button ,AL(`options',0,`',`')} Other options



Compression User Interface (Archive Options)

Default folder to add from - Enter or use the browse button to select the folder you wish to be the default location
when an add function is chosen.

 No user interface is displayed if add files are defined - The TurboZIP interface is not shown if this option is 
chosen, and the operation is carried out using the files defined for this operation. This option is particularly useful 
when used in conjunction with Auto Backup Scripts. 

 Do not insert to ZIP Set - Depending on the state of this option, when archives are created, they will or will not 
automatically be added to the current ZIP Set. 

 No progress indicator - The progress indicator that displays the course of creating an archive is or is not 
displayed based on the choice in this check box.

{button ,AL(`options',0,`',`')} Other options



Extraction (Archive Options)
This dialog is accessed from the Archive Menu, Options.
Overwrite options - when TurboZIP extracts files into an existing folder that already contains files, one of the 
following conditions can apply if a file with the same name already exists.

 Overwrite all - new files will replace existing files

 Do not overwrite - will not overwrite an existing file under and circumstances.

 Overwrite older files - does a date check and only overwrites if the file is older than the new one. This is done 
strictly by date; internal version information (if any) is not considered.

 Prompt - gives you the opportunity to decide on each file before it overwrites an existing file.
Extraction options - choose any of the following options to apply when TurboZIP is extracting files.

    Restore path names - if path (folder information) is stored within the archive, TurboZIP will restore it during 
extraction.

    Truncate long file names - long file names will be shortened using the DOS standard. 

    Skip files with long file names - files with long file names will not be extracted.

    Automatically skip files when errors occur - corrupted files (those with bad crc, an internal file checking 
mechanism) or those of unknown compression formats will be skipped. If a file is skipped, you will receive a 
notification message.

{button ,AL(`options',0,`',`')} Other options



Extraction Folder (Archive Options)
This dialog is accessed from the Archive Menu, Options.

 Extract to the temporary folder - files are extracted to the folder specified in the Program Options -Setup tab, 
available within the Tools menu entry.

 Extract to the same folder as the ZIP file - files are placed in the same folder, along with the ZIP file being 
opened.

 Extract to the following default folder - files are extracted to the default folder specified in the space below.

    Create folder using archive name - considering the folder option above, TurboZIP will create a new folder 
using the archive name.

    No user interface is displayed for extracting files - the Extract Wizard screen is bypassed when this option 
is chosen; instead, files are immediately extracted, using the folder specified by the chosen option above.

 Refer to Bypass the TurboZIP Interface (How To) for details on applying this option to speed up extraction 
operations.

{button ,AL(`options',0,`',`')} Other options



Select Destination Archive and Items to Add (Auto Backup)
This dialog is accessed when creating an Auto Backup Script.
Type in a destination archive - enter a file name or use the button to open a file window to browse for an existing
ZIP file. 
Browse button - click to open a file window, and browse to locate and choose files to add to your ZIP file. You can
use standard file selection methods to pick the files you want. Wildcard selection criteria, such as *.* or xyz?.doc, 
can also be used.

 After selecting files from one location, you can click the Browse button again, to add more files from the same or 
different folders.

Load button - click to use load the specifications from an existing Auto Backup Script (abs) file, including the file 
list. You may then add files and make other changes. The Auto Backup Script will be saved as the ABS file you 
originally named and will not make any changes to the file you loaded.
Remove button - click on any item(s) in the window using the standard file selection method to remove them from
the files to be added.
Window - this area displays a list of files selected to add to the ZIP file. If you have chosen an existing file, it does 
not display those files already in the archive.

 Add comment or password protect the items - check off this box to add a comment or password protection. If
checked, the Set Comment and Password wizard window will be presented next. When adding files to an existing ZIP
that already includes a comment and/or a password, a message will appear and this option will automatically be 
checked off so the comment may be reviewed and edited in the step that follows.
This option applies only to ZIP archives; ARJ and LHA archives do not accommodate comments or passwords.



Set Comment and Password (Auto Backup)
This screen only appears if the Include Comment or Password in the ZIP option is checked off in the Add Wizard: Select 
Destination Archive and Items to Add dialog.

Would you like to add or change the comment?        

 No, thank you disables the option.

 Yes, please makes the area below available for you to add your comment. 
If a comment already exists in a ZIP archive to which you are adding files, it will appear in the comment area. It can 
be edited or left intact.

Would you like to password protect the archive?

 No, thank you will cause the files you are currently adding to remain unencrypted. Any encrypted files in an 
existing ZIP will remain encrypted.

 Yes, please makes the area below available to enter your password; only those files currently being added will 
be encrypted with the password you enter.
If files contained within an existing ZIP archive, to which you are adding files, are password protected, a message 
appears alerting you of that fact. 

    Please see the Password and Encryption Notes topic for additional, important information about the use of 
encrypted files in ZIP archives.



Review (Auto Backup)
This dialog is the last step in the sequence of creating an Auto Backup Script.
Window - this are displays a list of options that will apply to the ZIP file, for your review. The Configure button, 

below, allows you to make changes.
Configure button - make changes, or review Archive Options tabs (Compression , Advanced Compression , 

Compression Filters Auto Backup ) by clicking on this button.

 Changes you may make through the Configuration button apply to this archive only; to make changes to 
any TurboZIP default settings, access Archive Options from the Archive menu entry.

When you are satisfied with your options, click on the Finish button to build your ZIP file.
TurboZIP will display a dialog asking if you want to backup your files to the ZIP file after you click the button. This 
gives you the option to create the file, or, if you select "No," the Auto Backup Script will be saved but the archive 
will not be created at that time.



Auto Scan (Program Options)
This dialog is accessed from the Tools Menu, Program Options.
Auto Scan File Types - use the box at left to choose file types to be added, or enter them directly, including 

wildcards to specify selections. A semi-colon (;)must separate selections.
Enter a folder name for Auto Scan to look in: enter a path and folder or use the browse button to select one,

 Scan subfolders - check off to includes subfolders in the scan.

 Do not activate window for scheduled Auto Scan - this option disables the window display, and should 
probably be used when the Command Line option for an Auto Scan is used.

{button ,AL(`options',0,`',`')} Other options



External Program (Program Options) 
This dialog is accessed from the Tools Menu, Program Options.
TurboZIP requires external programs only if you wish to create ARJ and LHA archives. TurboZIP does not require 
any external programs to open, view, or extract files from ARJ and LHA (lzh) archives.
Use the browse button to locate ARJ.EXE and LHA.EXE on your computer to enable the creation of ARJ and LHA 
archives.
If you do not have these programs, you will find them available from hundreds of popular shareware file sites on 
the Internet. However, if you do not expect to encounter these archive types, which are very rare in comparison to 
the most popular file types supported by TurboZIP, it is not necessary to obtain them.

Two versions of ARJ.EXE are compatible; however, while version 2.5 will work, it does not support long file 
names. Version 2.60 is preferred.
Version 2.12 of LHA is the minimum required version.

 If you retrieve and use ARJ and LHA, please read and observe the licensing requirements of each program.

{button ,AL(`options',0,`',`')} Other options



Preview (Program Options)
This dialog is accessed from the Tools Menu, Program Options.

 Fit image in window - when checked, image files are reduced or enlarged, proportionately, to fit the current size
of the Preview Pane. 

 Sound off- when multimedia files are previewed, sound is suppressed.

 Word wrap- if the current horizontal size of the Preview Pane is not wide enough to display a complete line of 
text, the offending lines are wrapped so they may be read.

 Fit video in window - when checked, video files are reduced or enlarged to fill the Preview Pane and may not 
retain their proper proportions.

 Keep video size - when checked, video files are presented at their recorded size, and can potentially overflow 
the current dimensions of the Preview Pane

 Do not preview files whose sizes are over - check off this box, specify a file size and value; this option is 
useful to avoid any potential delay when loading large files for preview. The TurboZIP preview is extremely efficient 
and quick, and trial uses with large files may be advised before using the option and specifying a value appropriate 
for your machine, if the restriction is desired.

 Control-Shift-M is the keyboard shortcut to toggle the Preview Pane to the full size of the TurboZIP window.

{button ,AL(`options',0,`',`')} Other options



Setup (Program Options)
This dialog is accessed from the Tools Menu, Program Options.
ZIP Set folder - Enter or use the Browse button to select a folder for storing ZIP Set
Temporary folder - Enter or use the Browse button to select a folder to designate as the TurboZIP temporary 

folder.

 TurboZIP should check to see whether it is the default ZIP program - For best integration with Windows, 
TurboZIP associates itself to all supported file extensions. Sometimes, other programs, when installed, may change 
these settings and interfere with your normal operations. When checked, this option verifies and notifies you if these 
associations have changed, so TurboZIP can correct the situation at your request.

 Load on Windows startup - When checked, TurboZIP will be launched when Windows is started so it is 
available immediately during your session.

 Display the full path of the Archive and E-mail - The full path shown in the ZIP Set pane can be suppressed 
when this option is deselected; only the file name is displayed.

 No splash screen - When checked, the TurboZIP splash screen (logo image) will be bypassed and not 
displayed when the program is launched.

{button ,AL(`options',0,`',`')} Other options



Virus Scan (Program Options)
This dialog is accessed from the Tools Menu, Program Options.
Program path: - enter or browse to the selected virus scanner program
Parameters: - enter command line parameters for your virus scanner; consult the program's documentation for 
specific requirements.

 Run minimized - check this box to let the virus scan run minimized, if you would prefer it to not open a window 
for observation.

{button ,AL(`options',0,`',`')} Other options



Configure Filters (preview associations)
This dialog is accessed from the Tools Menu, Preview Filters.
TurboZIP uses a method similar to Windows to associate file types, by their extensions, to a specific filter so the 
contents of each file type is displayed properly. Over 100 special filters are supplied and categorized by document,
clip art, image, multimedia, spreadsheet, and general, and each is associated to one or more file extensions. 
In general, it should not be necessary to make changes to the default filter associations. However, the three 
buttons are made available so you may customize the TurboZIP filter associations. Reasons might include a 
specific file extension with the same characteristics as one of the common extensions used by TurboZIP. Adding 
and defining it to a common type could enable you to preview it.
Highlight the filter category prior to clicking any button
Add Filters allows you to add new filters.
Change Filters displays the current filter and file type associations, allowing you to change them.
Remove Filters shows listings of currently associated extensions and allows you to delete any selection.
First, select the category of filters you wish to affect, and then make your selection.



Add Browsing Filter (preview associations)
This dialog is accessed from the Tools Menu, Preview Filters; refer to Configure Filters for details about this function.
This dialog allows you to add extensions and assign them to a specific decoding filter, so that they may be viewed 
properly.
Browsing Filter: Enter the file extension as a wildcard; for example: *.ext
Specification: Enter the file extension(s) you wish applied as the filter

 Use existing decoding filter - This option will place the extension(s) in the "unknown" category. As a result, 
TurboZIP will examine the file and try to identify the type, and apply the appropriate filter. This is especially useful if 
the same extension is being used for two distinct file types. If it cannot be identified, it will be displayed in 
hexadecimal format.

Select decoding filter: Highlight the filter type to be applied. Selections are unavailable if the option above is 
checked off.



Change Browsing Filter (preview associations)
This dialog is accessed from the Tools Menu, Preview Filters; refer to Configure Filters for details about this function.
Click on a file extension filter in the upper box; the browsing filter and specification are displayed, with the current 
decoding filter highlighted in the lower box. Either can be changed.

 Use existing decoding filter - This option will place the extension(s) in the "unknown" category. As a result, 
TurboZIP will examine the file and try to identify the type, and apply the appropriate filter. This is especially useful if 
the same extension is being used for two distinct file types. If it cannot be identified, it will be displayed in 
hexadecimal format.



Remove Browsing Filter (preview associations)
This dialog is accessed from the Tools Menu, Preview Filters; refer to Configure Filters for details about this function.
Highlight the browsing filter necessary to be removed, and click on Remove. Careful consideration should be given
before removing a filter, since it will disable the defined link to the filter for that item in order to display it properly in 
the preview pane.



Uninstalling TurboZIP

TurboZIP complies with Windows 95/98/NT standards by providing an entry in the Add/Remove programs section. 
Simply select the program from the list and click the Add/Remove button to begin the uninstall process.
In order to uninstall completely, TurboZIP must not be running. If the interface is open, click on the File menu and 
choose Exit. If the TurboZIP icon is in the system tray, right click on it and select Exit. Now you may continue with 
the uninstallation process.

 If you have placed any additional files in the TurboZIP folder, they will not be deleted. It will be necessary to 
manually delete the folder and setup.exe after you uninstall the program.

If you are uninstalling TurboZIP due to dissatisfaction, an omission, or any other reason that we should know about, 
please send a message to support@pgcc.com expressing your point of view. It is our goal to produce the most useful
and fully featured archive tool available, and welcome your comments and criticisms.



Turbo Browser is another product from 
Pacific Gold Coast Corp., that offers 
excellent file management, searches, 
the unique Qbar, transparent and fast 
Internet access, as well as sophisticated 
file viewing capabilities.




